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Oracle 11i Getting Started Guide


Getting Started with DCPDS under Oracle 11i

	Purpose
	This document provides instructions to help you get started using the Defense Civilian Personnel Data System (DCPDS) after the migration to Oracle 11i.  It covers the key changes that you need to be aware of as a result of the migration.  The last part of the document (“Specialized Changes”) covers functions that are likely to be of more interest to CPOC users.  


	Contents
	This document provides instructions and information for the following changes in Oracle 11i:


	Topic
	See Page

	Logging on and Exiting
	2




	Toolbar and Keyboard Changes

	7




	Changes to the Request for Personnel Action (RPA)

	8




	Printing

	10




	The Inbox(es)

	17




	Specialized Changes


	Person Summary
	21

	Position Window
	22




	Viewing Date Track History

	25


	Background
	Oracle HR, the commercial software application that forms the backbone of DCPDS, is moving to a web-based platform called Oracle 11i.  DCPDS is therefore also moving to this updated platform.  Prior to this upgrade, DCPDS had been using Oracle HR version 10.7, which runs on a client-server platform.  

The migration period begins on 18 Jul 2003 and will be complete by the beginning of Aug 2003. During the transition period, the DCPDS database will not be available.  Once the migration is complete, DCPDS will re-open for CPOC use only on 1 Aug 2003, and for all users on 4 Aug 2003 – but with some changes in appearance and method of access.  In addition it will have some new features. This guide is intended to assist you in getting started with this upgraded version of DCPDS once the migration is over. 


	For more information
	· The CPMS 11i Quick Start Guide has more detailed information about the changes in Oracle 11i, which is available on the CPOCMA Oracle 11i web site:  http://www.cpocma.army.mil/oracle11i. References to pertinent pages in the CPMS 11i Quick Start Guide (March 06, 2003 version) are included in this document.  

· The CPOCMA Oracle 11i web site contains other useful information about Oracle 11i, including a series of narrated ScreenCam “movies” that demonstrate some of the same changes covered in this document.  References to pertinent ScreenCam movies are included in this document.

· For information about performing basic functions in DCPDS (such as creating, routing, or printing an RPA), see the DCPDS Desk Guide at http://www.cpocma.army.mil/deskguid.  This guide is being updated to match Oracle 11i, but in the meantime, the step-by-step instructions remain the same for most operations (except as shown in this Getting Started guide). References to pertinent sections in the Desk Guide are also included in this document.  


	Workstation requirements
	Although the upgraded DCPDS is web-based and uses a standard web browser to access, users need to have two software applications loaded to their workstations in order to use DCPDS under Oracle 11i:

· Oracle Jinitiator, a Java application, and

· Ghostview, a postscript printing application that enables your workstation to view and print postscript documents produced by DCPDS (such as Requests for Personnel Actions (RPAs), Notifications of Personnel Actions (NPAs), NAF Forms 3434, and DD Forms 1556).

See the CPOCMA Oracle 11i web site (http://www.cpocma.army.mil/oracle11I) for the downloadable applications and installation instructions.


Logging on and Exiting

	The login process
	The logon process in Oracle 11i is different than in version 10.7, but you still begin the process from the Army Regional Tools (ART) main menu.  See the ScreenCam Oracle 11i Overview movie for a demonstration of the logon process and other basic changes.


	Step
	Action

	1
	Using your Internet browser, connect to the Army central site (https://armyweb01.ria.army.mil/art) and log into ART as usual.

	2
	From the ART main menu, select Central DCPDS (11i).

	3
	On the Oracle Rapid Install Release 11i window, click on <Apps Logon Links>:  
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	4
	The right side of the screen then displays “Logon Options.”  Click on <Personal Home Page>:  
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	5
	This will take you to the logon window.  Enter your DCPDS user ID and password, then click <Connect>: 
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	6
	You may or may not see the “Welcome/Navigate” screen shown below.  If you have more than one responsibility, select the one you want to use.  Otherwise, continue to step 7.
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Refer to 

	The Inbox(es)
, p. 17, for information about the inbox.
	

	8
	The Navigator menu will display shortly (see next section).


	Features of the navigator menu
	The Navigator menu is very similar to the Navigator used in the 10.7 version.  A few changes are identified below:
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	Exiting
	When you are done using DCPDS, be sure to close all windows that were opened during your session. 


	Changing passwords
	To change your password, from the Navigator menu click the Edit menu, then select Preferences ( Change Password.


Toolbar and Keyboard Changes

	Toolbar changes
	Icons on the toolbar are pretty much the same, but they look different and are in a different order.  Hover your mouse cursor over a button to display its function. [CPMS 11i Quick Start Guide, pp. 12-13]
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	List of values
	There is no longer a “List of Values” (LOV) icon on the toolbar.  Instead, lists of values are embedded in each field for which there is a list, and the list can be accessed by clicking on the down arrow (or a button containing three dots) at the right side of the field.  Once the List of Values has displayed, use it the same as before.  Note, the LOV button is not visible until you have actually clicked in the field. 
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	Queries
	If you use queries in DCPDS (e.g., to retrieve position records, or find a particular DDF in Extra Information), the keys used to run queries have changed.  Instead of using [F7] to start a query and [F8] to run it, use [F11] to start the query function and Ctrl-[F11] to run the query.  [CPMS 11i Quick Start Guide, pp. 16-18]  


Changes to the Request for Personnel Action (RPA)

	RPA families
	The Request for Personnel Action (RPA) section on the Navigator menu has new sub-entries for “Salary Change,” where you select a more specific type of salary change (promotion, change to lower grade, quality increase, etc.)
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	RPA changes
	The RPA is essentially unchanged except the <Prev> and <Next> buttons used to move from page to page on the RPA have been replaced with tabs:  Requesting Info (p.1), Position Data (p.2), Employee and Position Data (p.3), and Remarks and Address (p.4) across the top of the RPA.  Click the desired tab to move to that page. [CPMS 11i Quick Start Guide, p. 31] 
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Printing forms

	Printing an RPA
	The processes for printing Requests for Personnel Action are the same as in the 10.7 version.  You can print from the RPA itself (using the Print icon), or select Request for Personnel Action from the Processes and Reports selection on the Navigator menu.  [Desk Guide, RPA section, also see the ScreenCam movie on Oracle 11i Printing.]


	Printing NPAs
	Notifications of Personnel Actions (NPAs), or SF50s, can be printed using one of the following options:

· You can print an NPA from the RPA once the action has been processed and the effective date has arrived.  However, you must use the Civilian Inbox, not the Workflow Inbox, to do this (you cannot view a closed action using the Workflow Inbox).  See Other workflow inbox, p. 20.

· You can print an NPA from the Processes and Reports selection on the Navigator menu (process described below). 

· You can also “batch print” a number of NPAs at one time using the Processes and Reports selection on the Navigator menu. [Desk Guide, Retrieving Information section]


	Submitting a report request
	The process for submitting a report request from the Navigator is similar to the way this was done in version 10.7, with a few small changes.


	Step
	Action

	1
	From the Navigator menu, navigate to Processes and Reports ( Submit Process and Reports

	2
	The “Submit a New Request” window opens, asking if you want to submit a Single Request (default) or a Request Set.  Make sure Single Request is selected, and click <OK> (“Request Set” is used only by sysad staff in the CPOCs).    
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	3
	The “Submit Request” window opens. 

[image: image12.png]= Submit Request

Run this Request...

Narme.
Parameters

Language

Atthese Times...
G As Soon as Possible
Upon Completion...

iSave all Output Files







	4
	Click the List of Values button in the “Name” block to display a list of reports available, or, if you know the name or part of the name, type it and push the [Tab] key.  Typical reports run from this menu include the Request for Personnel Action, Notification of Personnel Action, and Batch Print Notification of Personnel Action.
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	5
	Once you’ve selected the report, a “Parameters” window will display where you will enter the parameters for the particular report you are running (these will vary by report).  For instance, to run a Notification of Personnel Action, you need to identify the employee and the action you want, and whether you want the front, back, or both pages to print.  Begin by entering the employee’s last name and pushing [Tab]:
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	6
	When the list of matching names and actions displays, select the one you want and push <OK>:
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Complete the “Parameters” window by indicating if you want the front or back page, then click <OK>.

	7
	The only other thing you may need to change on the “Submit Request” window is the “Upon Completion” area.  

· If you are printing to the “0_default” printer (a non-existent printer which is the default for users outside of CPOCs and CPACs), you should change the number of copies from 1 to 0.  

· For CPOC/CPAC users, if you want to select a different printer, you can also do that.  

· Begin by clicking the <Options…> button in the “Upon Completion” area, then change the Copies block to 0, then click <OK>.
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	8
	Finally, click the <Submit> button on the now-completed “Submit Request” screen.  The “Requests” window opens automatically and you can begin with step 3 of “The printing process” described below.


	The printing process
	When you submit a print request (e.g., printing an RPA using the Print icon or submitting a report request from the Processes and Reports menu), you access the “View My Requests” window differently.  


	Step
	Action

	1
	Instead of using the “Help” menu and selecting “View My Requests,” use the “View” menu and select “Requests.” 
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	2
	The “Requests” window opens with a “Find Requests” window (shown below) on top. Click the <Find> button to display your requests (you can enter search criteria if desired, but this is not necessary).
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	3
	Your list of report requests displays, with your most recent request at the top of the list (in the example below, some of the more recent requests were having a problem!).
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If you are using the 0_default (dummy) printer and did not change the number of copies to 0, the request will show a “warning,” but this will not affect your report.

	4
	If the request has not completed (phase column reads “Pending” in green), click the <Refresh Data> button to refresh the screen.  Once the request is complete, click the <View Output> button to view the report. Ghostview, a third-party application that allows you to view and print postscript files in DCPDS, opens with your report showing:
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	5
	To print a hardcopy, select File ( Print from the Ghostview menu. [Desk Guide, Retrieving Information section]


The Inbox(es)

	Two inboxes available
	There are two inboxes available on the Oracle 11i navigator menu.  Both have the same function and either one can be used. 

· The Civilian Inbox is the Oracle 11i equivalent of the Oracle 10.7 inbox.

· The Workflow Inbox is new to Oracle 11i (see the ScreenCam movie on Oracle 11i Workflow Inbox).
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	Which one to use?
	The two different inboxes each have their own advantages (and disadvantages).  Select the one that is best for you.  You do not need to stick to one at all times – you can use one during one session and the other during another session if desired, although you should not have both inboxes open at the same time. 


	Civilian Inbox (10.7)
	Workflow Inbox (11i)

	Already familiar to users.
	New, unfamiliar look.

	Provides more columns of information about items in the inbox (e.g., pay plan-grade).
	Has only limited information about items.

	Replaces the navigator window when opened.
	Opens in a separate browser window so you can have it open at all times even when performing other DCPDS tasks.

	Allows you to set up “views” with different selection and sorting criteria but the process is not user-friendly.
	Provides an easier process for setting up different “views” with different selection and sorting criteria.

	Can only select one item at a time.

· Can only route one action at a time.
	Allows you to select more than one action at once.

· May allow mass routing of actions (not currently working).

	Can view and print open or closed actions.
	Cannot view (or print) closed actions.

	The <Respond> button (to display the RPA) is available from the inbox screen.
	Must “open” an action in order to access the <Respond> button to display the RPA.

	Can export data from the inbox.
	Cannot export data from the inbox.

	Will eventually not be available.
	Will eventually be the only inbox available.


	Civilian inbox
	The Civilian Inbox in Oracle 11i is the equivalent of the Oracle 10.7 inbox.  It works almost the same as the inbox with which users are familiar. [Desk Guide, Civilian Inbox section] 

There are a few changes to this “old” inbox that users need to be aware of:

· Use the new “refresh” key combination to refresh the inbox:  [Ctrl]-[F11]  This needs to be done whenever you have routed an action from your inbox, or when you have closed an action.  It also allows you to see any new items that have arrived since you opened your inbox.

· To see a new action that you have initiated and saved to your inbox, use the View ( Find All menu selection to see the new action in your inbox.

· If you use the “Comments” field in the inbox, you cannot update it directly from the inbox screen. You have to open the “Notifications” window (using the <Open> button on the inbox screen) and update the “Comments” field there.

· To sort the items in the inbox, you must use the Folder Tools icon.  Resorting the inbox by using the column fields is not available.


	Displaying an RPA from the workflow inbox
	The “Workflow Inbox” is the new Oracle 11i version of the inbox on the navigator menu.  When you select this, your “Worklist” displays in a separate window. 


	Step
	Action

	1
	When the Workflow inbox displays, click on the underlined link in the subject field of the inbox for the RPA that you want to work on.  
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	2
	This opens the “Notification Details” window.  From here, scroll down to the “Response” area and click on the RPA icon to open the RPA itself (a “Launching Form” window displays, it will close automatically).  
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	3
	The RPA will display in a different window.  Review and/or change the RPA as needed.

	4
	When you close the RPA (or route it to someone else), you will return to the “Notification Details” window.  Click on “Return to Worklist” to return to your inbox (don’t just close this window as this will also close your inbox).


	Other workflow inbox changes
	Some of the other changes in the workflow inbox are described below.   [CPMS 11i Quick Start Guide, pp. 33-50]


	Task/Function
	Description/Instructions

	Search for an RPA
	Use the <Simple Search> button to search for a specific RPA (or group of RPAs).  Enter your search criteria – use the “Subject” block to search for a type of action (e.g., Recruit) or a specific RPA number.  You don’t need to use wild cards and the field is not case sensitive.  Click <Go> after you have entered your criteria.  <Advanced Search> provides additional search options.

	Closed RPAs
	The workflow inbox displays open notifications by default.  To access closed actions, use the drop-down “View” menu, select “All Notifications,” and click the <Go> button.  Note, however, that you cannot view actual closed RPAs from the inbox, you can only see the “Notification Details” about closed actions.  To view a closed RPA, use the Processes and Reports function.

	Refreshing the inbox
	Actions that you route to someone else will automatically drop from your inbox view.  However, to see any new actions that have arrived, you need to refresh the inbox using the <Go> button on the inbox window.

	Modifying views
	See the CPMS 11i Quick Start Guide, pp. 45-48 for instructions on modifying standard views or to create your own views (e.g., to only display one type of action or see only groupbox actions), and pp. 49-50 for instructions on creating rules to automatically route inbox items to another user.  Also see the ScreenCam movie on Oracle 11i Inbox Views.

	Sorting
	To sort the items in the inbox, click the column heading on the item you want to use for sorting. To set up a different sort for any of your inbox view(s), use the <Personalizing> button.


Specialized Changes

	Summary
	The next sections cover changes and new features in DCPDS that will be primarily of interest to CPOC users, although other users may also find them of value.  


Person Summary

	Person summary
	The “Person Summary” is a new feature that provides quick access to basic data from an employee’s record organized into various categories. This is read only data.  [CPMS 11i Quick Start Guide, pp. 70-76, also see the Oracle 11i Person Summary movie]

Note that you can also access the Person Summary from an RPA by clicking the <Others> button and selecting Person Summary from the Navigation options list.  This is handy if you are processing an action and don’t want to close the RPA to look up a piece of information about the employee.


	Step
	Action

	1
	From the navigator menu, select People ( Enter and Maintain.

	2
	Use the “Find Person” window to retrieve the record of the employee that you seeking (same as before).

	3
	Click the <Others> button and select “Person Summary” from the navigation options.
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	4
	The “Person Summary” displays with the first three tabs visible. Additional tabs can be displayed by clicking the double arrow icon at the right side of the tabs.

[image: image25.png][8 Ferson summaryiaaut, veua

Pt W-_

Person: iforation | Person: Mitary/Education | Assignment: Inormaton

Dt of Bt
Citizenship

Race or Nationsl Orgin
Apponiment Type.

Typs of Employment

FERS Comrage

Previous Retirement Cavrage
‘Agency Code Transfer From

Gender (M~ Persan: Miltary Education
izon, in. * Assignment:Information
White, ot of

Date Last Promotion (10JUL2000

Date Comreion Carear Beging
Date Conversion Career Due
Dats VRA Comersion Due

Astignment. ProbationRetsined Grads.
Posiion: THl/Pay Plan/Grade/Etc.
Posion: Extra nformation
Posion: Organization/Agpropristion Code/Etc.
Pay Salary
Pay. Banelis
Peromance
Awards/Bonus
Noifcaton of Personnel Actions
Ghlan (26 FEBA01
R 26.FE0-1901
TSP








Position Window

	Position window
	The way you retrieve a position record has changed in Oracle 11i.  A “Find Position” window, similar to the “Find Person” window, displays in which you enter criteria for retrieving a position or group of position records.  Access to the position window is, however, the same.  [CPMS 11i Quick Start Guide, pp. 51-58, also see the Oracle 11i Position movie.]


	Step
	Action

	1
	From the navigator menu, select Work Structures ( Position ( Description.  The “Find Position” window displays.
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	2
	To build a new position, click the <New> button on the “Find Position” window.  This displays the Position window where you can begin entering data.

	3
	To retrieve a position(s), use any of the fields on the “Find Position” window to enter your search criteria. 

· If you click in the “Name” field, the “Position Flexfield” window displays to allow you to enter query criteria for the position description number, title, sequence number, agency group (component and major command), and/or position type (APPR, NAF, etc.).  Click <OK> after entering any criteria in this window.  It will display in the proper format on the “Find Position” window.

· Be sure to delete the sequence number that displays when this window opens before clicking <OK> (if you are searching by sequence number, replace this with the sequence number you are looking for)
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Note, you can also use the regular query method directly on the Position window itself (the way we used to do it, but using the [F11] – Ctrl-[F11] keys to enter and run the query instead of [F7] and [F8]).  This is instead of using the “Find Position” window.  

	4
	Click the <Find> button on the “Find Position” window after entering your search criteria.  This will retrieve the position(s) that meet your criteria.


	Copying positions
	To make a copy of an existing position, do not use the instructions in the CPMS 11i Quick Start Guide, pp. 59-63.  The “Position Copy” function (accessed from the navigator) is not working properly.  Instead, open the position window and retrieve the position you want to copy, then click the <Others> button and select “Quick Copy” from the bottom of the navigation options list.  The Quick Copy function works the same as before.
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	End-dated positions
	When a position has been end-dated and you need to use it again, use date tracking to remove the end date, then change the “hiring status” (a new data element on the position screen).  For example: Upon conversion to 11i an encumbered position had an end-date of 31 Jul 2003. The “hiring status” changes to Eliminated on that date. To un-end date the position, date track back one day prior to end-date (30 Jul 2003).  This automatically changes the “hiring status” field to Active, but you have to click on the “hiring status” field and manually change it to Active before you can save this change. The system will ask if you want <Update> or <Correction> -- click on <Update>. The system will then ask if you want to <Replace> or <Insert> -- click <Replace>, then save.  You will also need to revalidate the position.


Viewing Date Track History

	Viewing date track history
	To view the history of changes made to a record over time (applicable to date tracked records including the Person and Position records), click the “Date Track History” icon on the toolbar (far right).  The “Date Track History Change Field Summary” window displays, showing “From” and “To” dates and the fields that were changed (one row per time period). 
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	To see more detail, click the <Full History> button. [CPMS 11i Quick Start Guide, pp. 28-29]

[image: image30.png]From Date [To Dat [Disabled

D1AUGZNZ  [11AUG2002







PAGE  
Getting_Started_11i.doc
1
21 Jul 2003

